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Chapter 7
Introduction to the Microsoft Access Database

Objectives

This laboratory exercise introduces the database called Microsoft Access. You will
explore the help manual that is provided with Access, examine a previously created
database and modify this previously created database. This lab is restricted to a database
that consists of just one table.

This lab will cover:
e Adding a new field to a table
¢ Adding and deleting records
e Creating a Form
¢ Creating a Report
e Creating a Query

Preparation
Read the whole of the chapter before beginning the exercises.

Exercise 1 — The Help Manual

Launch Microsoft Access from the Start/Programs/Microsoft Office menu.

Access 2003/2002:
A window will appear asking if you want to create a new database or open an existing
database. Do neither — just click on the Cancel button. You will now just have an empty
window for the Microsoft Access application. Click on Help from the command menu
and choose Microsoft Access Help. In the help wizard balloon type Get Started and
then click on the Search button. Then choose Get Started with Microsoft Access 2002
followed by Using a database for the first time. The window shown in Figure 7.1a
appears, and you should read carefully the sections named:

¢ Databases: What they are and how they work

e Tables: What they are and how they work

e Queries: What they are and how they work

e Forms: What they are and how they work

e Reports: What they are and how they work

Use the Back button to return to the window shown in the figure when you have finished

reading a section. Within a section there are a few pages to read as indicated by the
numbers that appear at the top left of the window once you enter a section.
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Figure 7.1a — the introductory help material
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Access 2007:
A welcome window will appear with the banner Getting Started with Microsoft Off ice
Access across the top. Click on the question mark at the top right corner of the Access
window and the Access Help window shown in Figure 7.1b appears, and you should read
carefully the sections named:

e Getting started

e Database design

e Database basics

e Tables

e Queries

e Forms

e Reports
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Figure 7.1b — the introductory help material
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Use the Back button to return to the window shown in the figure when you have finished
reading a section. Within a section there are a few pages to read as indicated by the
numbers that appear at the top left of the window once you enter a section.
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You should gather from reading this information that tables - more commonly called
relations - within a database somehow divide up the data into “topics”. Queries on the
other hand are used to retrieve data from the database (sometimes by combining data
from different tables). Forms are used primarily to provide a simple way to enter data into
the database since they can selectively display certain fields for which the database user
must enter data. Reports, as the name implies, are used to create nicely formatted
summaries of the data including graphs of various types for a report.

Hopefully this has given you an overview of the database application. We are going to

focus on creating queries, forms and reports using a database with a single table in the
rest of this lab.

Exercise 2 — the Athlete Database

Copy Exercise 2 (Lab_7(.mdb)) found in Support Files (Chapter 7) on the course
website to a folder you create called, say, Lab7 in your own account or computer.

Open this database file - by double clicking on it, for example. The window shown in
Figure 7.2a should appear for Access 2003/2002 and Figure 7.2b for Access 2007. Notice
that the Tables tab is selected (if it’s not, click on it now) and that one table called
ATHLETE exists in the database. In Access 2003/2002, click on the other tabs — Queries,
Forms, etc. and you will see that no other objects exist in this database. In Access 2007,
click on the little downward pointing triangle to the right of Tables tan, and click on the
other tabs — Queries, Forms, etc. You’ll add some of these things shortly.
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Figure 7.2a — The athlete database in Access 2003/2002
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Figure 7.2b — The athlete database in Access 2007
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Return to the Tables tab, and in Access 2003/2002 select the ATHLETE table and click on
the Open button, or in Access 2007 double-click on the ATHLETE tab. You should see a
table of data appear as shown partially in Figure 7.3. This table consists of 25 records
(you can see that specified at the bottom of the window) and each record has 9 fields
named ID, Name, Height, Weight, etc. This table is the raw data if you like. In general
you or another user of the database would not want to add or delete data directly using
this table. Although you could do so, it is not particularly convenient.

Figure 7.3 — the athlete table in the Athlete database
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Click on the right pointing arrow at the bottom of the ATHLETE table window and
observe that you can move down the list of records. It is possible to change the data in a
field of any record and to add new records to this table.

To add a new record move to the very bottom of the table (you can do this by clicking on
the button showing a right pointing arrow and an asterisk), click in the Name field and
type a new last name (your own perhaps). Fill in the other fields as well and you’ll have a
complete new record.
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To change data simply position the cursor in the field that you want to change, delete the
existing value and type the new one. Try this with the new record you just added. You
can also delete a record. Make sure the record you just added is selected (click on the far
left so that the whole row is highlighted) and, in Access 2003/2002 choose Edit/Delete
record from the command menu or in Access 2007, choose Delete in the Records group
within the Home tab.

Access will ask you to confirm that you want to delete the record, and this illustrates an
important feature of a database. Generally the changes you make are immediately made
in the version of the database that is stored on the hard disk. Most other applications store
changes in main memory without affecting the file that is stored on disk. If you quit most
other applications without first choosing File/Save or File/Save As you would then be
asked if you want to save the data, i.e. the changes you had made. You’ll find that you
can quit Access without being asked to save a file — and this is because the changes you
make have already been made to the disk file.

Creating a Data Input Form

There are many ways to create a form. After you have followed the steps here you should
experiment with the various methods that you will see in passing while doing it the way
described here.

We would like a simply designed layout that will make data entry an easy task.

Access 2003/2002;

Click on the Forms tab and then the New button. A New Form panel will appear listing
a few options available for creating a form. Choose Design View and, from the pull
down list in the text box labeled Choose the table or query ..., choose the Athlete
table (which is the only one available) and then click the OK button.

Access 2007:

Click on the Tables tab and then click on the Forms tab. Now click on the Create tab,
and then click on Blank Form within the Forms group. Next, click on the Create tab
again, and then click on Form Design within the Forms group.

The window and toolbar panel shown in Figure 7.4a should appear for Access 2003/2002
and Figure 7.4b for Access 2007. This is an empty form displayed in the Design view.
The Design view is the mode that lets you design the appearance of the form using the
various tools shown in the toolbox panel on the left in Figure 7.4a (Access 2003/2002)
and in the ribbon above in Figure 7.4b (Access 2007). We’ll create a two page form with
tabs that let us switch between the pages. One page will contain the athlete’s id, name,
height and weight. The other page will contain the various performance measurements
such as reach, jump/reach etc.
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Figure 7.4a — the form design view in Access 2003/2002
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Roll the mouse over the objects displayed, for Access 2003/2002 in the Toolbox panel
(on the far left in Figure 7.4a) or, for Access 2007, in the Controls group (along the top in
Figure 7.4b), pausing at each one until a label appears that names the object. Amongst the
objects you should find one called Tab Control. (It’s a small icon that looks like two file
folders with tabs.) Click on this object, move the mouse back into the form window (the
mouse icon will be a cross with file folder and tabs) positioning it in the upper left corner
of the window and click. This places two pages named Pagel and Page2 in the form
window.

Take a moment to see that you can switch between the design view and the form view. In
Access 2003/2002, click on View in the Access command menu and then select Form
View. In Access 2007, click on View in the Views group at the extreme left end of the
ribbon and then select Form View. You’ll see the form window change — the background
grid will disappear and the two blank pages with tabs will be left. Switch between the
tabs by clicking on them. We have yet to add data to these pages, so return to the design
view by clicking on View/Design View from the command menus or ribbon again.

To add data to these pages in Access 2003/2002 you need to select the Field List button
from the toolbars. Roll the mouse over the various icons in the toolbars (not the Toolbox
panel, but the toolbars just beneath the command menus) pausing at each one long
enough to see its name appear. You should find the one called Field List next to the icon
showing a hammer and wrench. When you click on this icon a small panel displaying all
of the fields in the athletes table will appear. In Access 2007 the Field List is
automatically displayed when the new Blank Form was created. You want to place the id,
name, height, and weight fields on page 1. Make sure Pagel is selected and then select
these four fields by clicking on one of them and then holding the shift key down while
you click on each of the other three. Release the shift key and then drag the selected
fields onto page 1. You should end up with something like what is shown in Figure 7.5
for Access 2003/2002. The result for Access 2007 is the same, except that the
surrounding layout will look like Figure 7.4b.
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If you want to you can position and resize each of the field text boxes and the field
names. Click on any one of the fields and square handles will appear around it. Carefully
move the mouse around the selected field and you’ll see it change into a hand in Access
2003/2003 or a four headed arrow in Access 2007 (you’ll be able to drag the whole field
to position it) or a double headed arrow (you’ll be able to resize the box).

Select the Page2 tab, then select the remaining fields (Reach, Jump/Reach etc) and drag
them onto page 2. Position and resize them as you see fit.

Return to page 1 and double click on the tab itself. The window shown in Figure 7.6
appears, which allows you to change certain properties of the page. In this case we
simply want to change the name of the page — so change Pagel to Personal as shown in
the figure. Return to Page?2 and change its name to Measurements.
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This simple data entry form is finished — so use the View/Form View command to leave
the design mode. You’ll find that data from the athlete table is now displayed in the form.
You can still edit the data values and add new records or delete records and all such
changes will appear in the athletes table that we looked at previously. The only difference
is that the interface by which we do such data entry tasks is a lot cleaner.

Click on the x button to close the form window and you’ll be asked if you want to save
the form and to give the form a name. A suitable name would be DataEntry for example.

Creating a Report

A report is quite simple to create — at least if you’re satisfied with the design templates
that are provided with Access. Sometimes a bit of design tweaking is required, as you’ll
see in the following.

Access 2003/2002:

Select the Reports tab in the athlete database window and then click the New button.
This time choose Report Wizard rather than Design View as you did when creating a
form, and also make sure the athlete table is selected before clicking the OK button.

Access 2007:

Select the Reports tab in the Navigation Pane. (The Navigation Pane is the same area
where the Tables and Forms tabs are located.) Click on the Create tab and then click on
Report Wizard within the Reports group.

The window shown in Figure 7.7 will appear — the first in a series of steps that the Report
Wizard will guide you through. This step allows you to select the fields that you want
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displayed in the report. You can select a field in the Available Fields: list and click on
the single arrow button to send it to the Selected Fields: list. If there were more tables
in the database you could also select fields from different tables to include in the report.
In this case we want all of the fields to be in the report so simply click on the double
arrow button and you’ll see that all fields are transferred to the Selected Fields: list.

Figure 7.7 — selecting fields for the report
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Clicking on the Next button will take you to a window that asks if you want any
grouping. Grouping doesn’t make much sense in the context of this database (we’ll see its
use later) so simply click on the Next button to carry on. The following step allows you
to choose whether to sort the data according to some field. We’ll sort it alphabetically by
name but you’ll see you could easily sort by some other field or combinations of fields.

Click on the pull down list arrow in the top text box and you’ll see a list of the fields in
the database (Figure 7.8). Simply select the Name field from this list. The button to the
right of the text box indicates that the data will be sorted from A to Z (Ascending). Click
on this button and you’ll see it change to indicate Z to A (Descending). Set it back to A to
Z (Ascending) and move on to the next stage. Notice that it doesn’t make sense with the
data in this database to perform a multilevel sort. We’ll see a multilevel sort later.

The next panel allows you to choose how to layout the data. Experiment with the options

available to see what they are, but select the Tabular layout before moving on. Notice
also that the Landscape page could be chosen here if the data was particularly wide.
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Figure 7.8 — choosing a field by which to sort the records for the report
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In the next panel you can select the appearance of the title for the report. Examine each of
the options and select the one you like before moving on to the final step in which you
can actually specify the title for the report. A suitable title might be All Athlete Data.
Finally click the Finish button.

However, you’re not actually finished because when you look at the report you’ll see that
the column headings are too long to be properly displayed in some cases. You’re going to
have to fix that or your boss will think you’re hopeless!

Adjusting the Report Design

In Access 2003/2002, use the View/Design View menu command to enter the design
mode for the report. In Access 2007, click on Close Print Preview tab which leaves you
in Design View. You should now have a window similar to that shown in Figure 7.9.
Notice that the main window is divided into 5 parts labeled Report Header, Page
Header, Detail, Page Footer and Report Footer. The Report Footer area is currently
empty but the other areas each display elements of the report.
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Figure 7.9 — the design mode for a report
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Each of these elements can be edited since we’re in design mode. For example, in the
page header the column heading Jump/Reach is mostly obscured because the space
allocated for it is too small. One way to fix this is to expand vertically the space given to
it. To do this carefully move the mouse over the vertical ruler on the left edge of the
window to position it just above the block indicating the start of the Detail section. The
mouse shape should be a vertical double headed arrow with a horizontal line through it.
You can now drag the boundary down in order to expand the area allocated to the page
header. Once you’ve done this click on the Jump/Reach heading (handles will appear)
and drag the lower edge of the text area down. Adjust the Ball Toss heading in the same
way. You should obtain a result similar to Figure 7.10.

Figure 7.10 — adjusting the page header in the design of the report
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You also need to adjust the space allocated to the other column headings in the page
header — but these others will also require that the spaces allocated in the Detail section
also be adjusted to match whatever you do to the headings. You need to make a little
more horizontal space for the Weight and Vertical headings, so reduce the horizontal size
of the ID heading and the ID area in the Detail section. Next move the Height heading to
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the left a bit, and also the Height area in the Detail section. Now you can expand the
horizontal space for the Weight heading. Continue in the same manner in order to make
space for the Vertical heading. In Access 2003/2002, return to the View/Layout Preview
mode once you are satisfied. In Access 2007, select Layout Preview from View in Views
group at the extreme left end of the ribbon.

You’ll probably find that the report is still not quite right — there’s a thick horizontal line
that you have to move down a little way so that it properly separates the column heading
from the data in the report. You should be able to do this yourself.

Adding A Field to the Database

You would like to add a new field to the database in which to record the number of
training sessions an athlete has attended. The number of sessions will not exceed 5 and of
course will be O initially. To add the field you need to access the athlete table in design
mode. So first close any Form or Report windows that you might have open (saving
things or not as appropriate) and then click on the Tables tab in the athlete : Database
window in Access 2003/2002 or click the Tables tab in the Navigation Pane in Access
2007. The athlete table should be selected (it’s the only one in this database). In Access
2003/2002, click on the Design button on the right of the window. In Access 2007, select
Design View in View within the Views group. A window similar to the one shown in
Figure 7.11 should appear.

Figure 7.11 — the table design window
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In design mode we are able to change features of the original table from which the data
we have so far been using originates. The fields and the data type of each field is listed in
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the top part of this window. In the bottom part you can see the properties of the field that
is currently selected —the ID field in the figure. Click on the far left of the row containing
the Name field and observe the Field Properties area. Notice that the length of a name is
restricted to, say, 100 characters as indicated by the Field Size property shown in the
lower region of the window. Click on the data type Text in the Name field row and then
on the pop-up list arrow that appears in the data type region for this field. You should see
a pop-up list containing the possible data types that could be specified. Don’t change the
data type for this field — just examine them.

Scroll to the bottom of the list of fields and in the first empty row type the name
Sessions for the new field that will contain the number of training sessions the athlete
has attended. Then click in the Data Type column and select Number from the pop-up
list. Since we know that the number of sessions must be between 0 and 5 we can specify
some properties that will help us ensure that mistakes are not made when the actual data
are entered for this new field.

In the Field Properties area check that the Default Value is 0 (it should be set to 0 by
default). This means that whenever a new record is added to the table the value for
Sessions is set to 0 by default. Next you would like to set a validation rule for the input.
This rule will specify what the range of valid values for Sessions is. If the database user
tries to enter any value outside the range they will see a warning message that prevents
them from entering such a value. There are a number of ways in which you could enter
the validation rule. You could specify each value that is permitted by typing:

lor2or3or4or5

or you could use an operator such as

<=5
Either way is suitable in this instance, although clearly specifying a condition, as in the
second approach, is of more general use. You should also set the Decimal Places
property since you know there will not be any decimal figures in this field.

You have now finished defining the new field and you should return to the Datasheet
View (using the View menu). You’ll see that the table now contains a new column for the
field Sessions, but the field does not have any data values as of yet.

To enter the data values you should return to the form that you created previously and
add the new field Sessions to it. You’ll need to enter design mode and place the
Sessions field onto the Personal page of the form. You should end up with something
like Figure 7.12. You’ll find that it is quite easy to enter data into the Sessions field
now. Make sure you deliberately enter some values that do not meet the validation rule
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just to see what happens. Make sure that you end up with all athletes having attended 2
sessions except for Cirny, Ofijoki and Jecksin who attended 4.

Figure 7.12 — the Personal page of the data entry form
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Calculating Values from the Data in a Table

Athletes are ranked by an index rating that is calculated from the values for height,
weight, reach, vertical, agility and ball toss according to the following formula:

Index rating = height/weight*100 + (reach—2.24)/10 + 2*vertical
+ ball toss/7.5 — agility + 6

A calculated value such as this should be contained in a query. In this example we’ll
create a query that contains just the name of the athlete and the calculated value of the
index rating. In general however, queries can be used for extracting data from the
database, often for the purpose of analysing the data in some way, rather than just for
calculating values. So don’t be misled into thinking that this example we’re about to do is
the only purpose of queries.

In Access 2003/2002, click on the Queries tab in the althlete : Database window, then
on the New button and select Design View by clicking the OK button. In Access 2007,
click on the Queries tab in the Navigation Pane, then click on the Create tab and then
click on the Query Design tab in the Other group. The Show Table window shown in
Figure 7.13 will appear. This window allows you to select the tables and (other) queries
from which the data used in the query you are now constructing are to come. There is

7-17




The Glade CSE1520.03
) Computer Use: Fundamentals

only the one source of data in this athlete database example — so simply select the athlete
table and click the Add button.

Figure 7.13 — selecting the sources of data for the query
Show Table

Tables | Queriesl E\Dthl

Add

Close

You should see the field list for the athlete table appear in the Queryl : Select Query
(Query1) window. If you had other sources of data and were to select them the field lists
for those sources would also appear in the Query 1 : Select Query (Queryl) window.
Close the Show Table window.

Let’s first add the Name field to this query. You can do this by selecting the Name field
from the small window for the athlete table in the upper portion of the query window
(Figure 7.14) and dragging it to the first column in the row labeled Field: in the lower half
of the window. Alternatively you can use the pop-up list activated by the down pointing
arrow on the right of the first column for the Field: row or you could just double click on
the Name field. Once you have entered the name field in this manner sort the query by
ascending name (i.e. A to Z) by clicking in the Sort: row and choosing Ascending from
the pop-up list.
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To add a calculated field to the query you need to construct the formula that will calculate
the value, entering this formula into the next column of the Field: row. The query will
then have two fields — the name and the calculated value.

Click in the Field row to the right of the Name field you just added and then, in Access
2003/2002 roll the mouse over the build icon shown here and click. In Access 2007, click
on the Builder icon in the Query Setup group.

W s EaNBSa- @)

This allows you to build a formula by clicking on the various components that the
formula requires. The window shown in Figure 7.15 appears. Double click on the Tables
and then click on the Athlete entry before what you see is the same as the figure.
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Figure 7.15 — the Expression Builder window (showing the Athlete table opened)
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Select the Height field and click the Paste button, then click the / button (or type a /) for
division, and then select the Weight field and click the Paste button. You have just
started to build the formula. Continue either typing symbols or selecting and pasting
fields until you have constructed the formula shown below, which gives the index rating.

[ATHLETE]![Height)/[ATHLETE]![Weight]*100+(ATHLETE]![Reach]-2.24)/10
+2*[ATHLETE]![Vertical+[ATHLETE]![Ball Toss]/7.5-[ATHLETE]![Agility]+6

Notice the parentheses ( ... ) around (reach-2.24)/10. Without them you would have
reach - 2.24/10 which is not what we want. Also observe that the table name ATHLETE!
precedes each field name in the formula.

When you close the Select Query (Queryl) window you will be asked if you want to save
it (yes) and to give the query a name — IndexRating would be suitable. Open the query
again and you should see the two columns shown in Figure 7.16 (except that yours will
be sorted by Name). Your values in the Exprl column should be the same as those shown
here if you have constructed the formula correctly.
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Figure 7.16 — the IndexRating query
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You have not finished with this formula yet, however. You realise that you should
include the Sessions value that you added to the athlete table a moment ago. Each athlete
is to receive an additional point to their index rating if they attended one or two sessions
and 2 points if they attended 3 or more sessions. This will require an IIF function to select
whether to add 1 or 2 to the index rating value. You will have to modify the formula for
the IndexRating to include this additional term.

Begin to edit the formula by selecting Design View from the View menu, clicking in the
Field row for Exprl and clicking on the build button. Make sure you type a + symbol at
the very end of the formula and then find the IIF function in the Functions/Built-In
Functions/Program Flow group of functions. The arguments are very similar to what you
encountered in Excel, so you should be able to construct the piece of the formula which
will add 1 if the sessions value is 2 or less, or which will add 2 if the sessions field value
is 3 or greater.
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Creating a Report from a Query

Now that you have the Query results displaying only the athlete name and the index
rating, create a report showing just these two values. The report should be nicely laid out
and should be sorted by increasing value of the index rating. Figure 7.17 shows the first
few entries as an example of the kind of report you might create. Notice that in addition
to being sorted the values of the index rating are formatted to display only 2 decimal
figures. A clue as to how you can do this is that you can select the Exprl field in design
mode and set its properties.

Figure 7.17 — a Report derived from the Index Rating Query

Athlete Name Index Rating
(includes Sessions)

Name: Crenne, T Index: 4.86
Name: Ulsin, E Index: 5.20
Name: Lendsduwn, Index: 5.23
Name: Bebiy, K Index: 5.29
Name: Striit, O Index: 5.30
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